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Imagen de 16 colores de ImageJ

Como se puede ver en las imágenes, aparece muy evidente como varía 
la luminosidad en las diferentes partes de éstas y será sufi ciente realizar 
un histograma, seleccionado antes el círculo de la foto, para saber 
cómo cada rango de luminosidad infl uye en el conjunto de la foto. 
Nos parece interesante evidenciar, cómo la luz que alcanza el punto 
no viene únicamente desde el cielo sino también de los elementos 
arquitectónicos que la refl ejan.
Si queremos, además, cuantifi car el peso, en porcentaje, de cada color 
en la totalidad de la imagen podemos guardarla en cualquier tipo 
de extensión y analizar esta última con un plugin específi co, Color 

Inspector, que se puede bajar libremente de Internet7.
Una vez instalado el plugin, tenemos que abrir la imagen guardada 
(File>Open) y abrir el plugin (Plugins>Color Inspector 3D). La ventana 
que aparece presenta una visión tridimensional de la distribución 
de color en la imagen. Cambiando el Display Mode en Median Cut 
y bajando la cantidad a 16, sabemos cuánto cada color, (pues cada 
nivel de luminosidad), infl uye en la escena. Pasando con el ratón en 
una parte cualquiera de la imagen, el programa nos está diciendo 
la posición, el tipo de color y el porcentaje (frequency) en relación 
al conjunto. El esquema tridimensional RBG nos está dando una 
rápida representación gráfi ca de las proporciones entre los colores. 
Con el ratón, se puede rotar el gráfi co para verlo de modo óptimo.  
Pinchando el botón LUT, tendremos un listado de los valores que 
buscábamos.  

Es fácil entender cómo comparando los valores tomados por un 
luminancímetro podemos saber, cuándo, dónde y con qué porcentaje 
una determinada cantidad de luz incide en un punto.

7  http://rsb.info.nih.gov/ij/plugins/color-inspector.html 



82

%

6.038

4.516

10.313

1.449

6.284

15.681

5.567

5.691

15.839

5.996

10.280

6.104

0.488

3.085

1.498

1.170

%

0.251

7.709

4.794

34.797

2.210

7.107

4.556

2.986

7.211

5.816

0.202

5.405

8.614

3.859

3.558

0.924

%

12.312

1.401

6.737

12.962

3.615

3.881

4.493

5.582

16.025

0.638

2.512

15.914

1.076

0.936

9.221

2.696

03.05.2010
h: 16.33
10 klux

06.05.2010
h: 14.35
96 klux

10.05.2010
h: 11.38
67 klux

N

S

E W

N

S

E W

N

S

E WA
ná

lis
is

 d
e 

pí
xe

le
s 

de
 fo

to
s 

sa
ca

da
s 

en
 e

l p
un

to
 ”

A”
 e

n 
di

fe
re

nt
es

 d
ía

s 
y 

co
nd

ic
io

ne
s 

at
m

os
fe

ri
ca

s 
di

fe
re

nt
es Graphical Representation of the Color Percent-

ages in pictures

Graphical Representation of the Color Percent-
ages in pictures

Graphical Representation of the Color Percent-
ages in pictures



83

A
ná

lis
is

 d
e 

pí
xe

le
s 

de
 fo

to
s 

sa
ca

da
s 

en
 e

l p
un

to
 ”

B
” 

en
 e

l 
m

is
m

o 
dí

a 
y 

co
nd

ic
io

ne
s 

de
 lu

z 
di

fe
re

nt
es

  %

17.251

  5.450

  7.283

  3.500

  2.611

  5.622

12.331

  9.168

  1.052

  0.938

  2.583

  6.842

  7.115

  7.502

  8.378

  2.371

   %

  3.397

  6.863

12.940

11.591

  9.852

  4.757

  5.073

  6.648

10.436

  4.542

  1.652

  1.856

  0.108

  0.339

  7.865

12.079

06.05.2010
h: 15.20
79 klux

06.05.2010
h: 15.35
22 klux

N

S

E W

N

S

E W

Foto Histogramas 
de grises

Imagen en 16 
colores

Porcentaje de 
albedo por 

porciones de 
colores



84

8.5 Fotografías HDR fi sheye y valuación de píxeles

Nos parece muy interesante presentar una técnica para analizar el 
cielo y el entorno en un punto, en este momento pionera pero que 
dentro de algunos años será, seguramente, importante en estudios 
del cielo y energía solar, que mezcla las posibilidades que nos da la 
fotografía hemisférica con las sorprendentes potencialidades de las 
imágenes digitales HDR. 
A causa de los elevados costos de los objetivos ojo de pez para 
cámaras digitales, hemos tenido que utilizar pequeños trucos de 
ordenador para poder experimentar lo que sigue a continuación. 
Por esto, no hay que considerar totalmente fi ables los valores que 
hemos obtenido y habrá que tomar esta parte como el intento 
de formular un método, más que como un estudio puramente 
científi co8.  
Teniendo un mínimo de tres imágenes fi sheye de la bóveda celeste 
sacadas con tiempo de exposición diferentes es posible obtener 
fotografías de alto rango dinámico que pueden ser analizadas con 
programas, como el WebHDR, como presentamos en el capítulo 8 
de esta tesina, y realizar elaboraciones de valores de luminancia en 
una escena. 

8  Por el hecho de haber utilizado una cámara analógica compacta que no 
nos permite modifi car el tiempo de exposición en saque de una foto y en cuanto 
la digitalización y las informaciones Exif, fundamentales para el análisis de imagen 
HDR, están hechas posteriormente al saque, ha sido necesario cambiar los valores  
de exposición con el Photoshop y construir unos archivos Exif  manualmente.

  

Con el análisis de WebHDR conseguimos 
cuantifi car en cd/m2 todo el entorno a 360º, 
sabiendo cuales son las porciones de cielo más 
o menos luminosas, y cual parte del construido 
puede refl ejar u obstruir la luz que llega en el 
punto, sin que sea necesario un cálculo de la 
luminancia con sofi sticados instrumentos.
Una vez elaborada la imagen gráfi ca y la escala 
de valores se puede pasar al análisis de píxeles 
con ImageJ para saber en qué porcentaje infl uye 
cada fracción de luminancia.
Abriendo la imagen guardada desde WebHDR, 
seleccionado el círculo de la foto, es posible 
analizar la imagen en color con el plugin Color 
Inspector (Plugins>Color Inspector 3D).

EV +2 EV +0 EV -2

Imagen falsos colores del Análisis de luminancia obtenida con WebHDR 
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Esta vez hemos divido la imagen en 10 colores, tantos cuantos son los 
intervalos de valores que obtenemos con WebHDR.    

En particular en nuestra imagen analizada sabemos que en el punto 
de saque se refl eja: el 2,452 % de luminacia superior/igual a 2172 
cd/m2; el 5% entre 1944 y 1715 cd/m2; el 6,6% entre 1715 y 1029 
cd/m2; el 11,6% entre 1029 y 800 cd/m2; 10% entre 800 y 572 cd/
m2; el 28% entre 572 y 114 cd/m2; 36 % igual o inferior a 114 cd/
m2;  

  Pixel %
1 14588 6.587
2 14956 6.753
3 21288 9.612
4 59087 26.680
5 32792 14.807
6 22147 10.000
7 29300 13.230
8 11185 5.050
9 10692 4.828
10 5430 2.452

4

5

6

7

8

9

10

1

1

2

3

Análisis de pixel con ImageJ de la imagen obtenida con WebHDR  
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[1]. Beckers B. & Masset L., 2009, Heliodon 2, Software and user guide, p.35-38 
[2]. Benoit Beckers, Luc Masset & Pierre Beckers, Una proyección sintética para el diseño arquitectñonico con la luz del, 8º CONGRESO IBEROAMERICANO DE INGENIERIA 
MECANICA, Cusco, 23 al 25 de Octubre de 2007
[3]. Ferreira, T. & Rasband, W., The ImageJ User Guide –Version 1.43, http://rsbweb.nih.gov/ij/docs/user-guide.pdf  , Apr 2010
[4]. Battiato S., 2005, Studio del software Java per l’ Image Processing ImageJ, Dipartimento di Matematica e Informatica, Catania
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Instrumentos fotográfi cos portátiles para el análisis de 
un sitio

En el desarrollo de nuestra tesis hemos encontrado ciertos instrumentos 
que permiten un análisis del sitio en relación a su entorno, utilizando 
técnicas fotográfi cas, dotados de pequeñas cámaras internas o externas 
al dispositivo. La mayoría de estas herramientas están producidas 
y comercializadas para la instalación de paneles solares, y algunos 
utilizan sistemas muy simples y convencionales. Nos ha parecido 
interesante dedicar un pequeño capítulo a estos instrumentos en 
cuanto su comercialización expresa las posibilidades de nuestro 
método. En particular, presentaremos ciertos productos, fabricados 
por diferentes marcas, que nos han parecidos muy interesantes y de 
fácil utilización.
Empezaremos nuestra exposición con el más simple e intuitivo, 
pasando poco a poco a sistemas más complejos y dotados de tecnología 
más sofi sticada.
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9.1 Solar Pathfi nder ™ [1]
 
El Solar Pathfi nder, producido por una empresa de  Estados Unidos, 
es un instrumento muy simple en su estructura y utilización. Es 
una herramienta no electrónica que funciona por refl exión y sirve 
para determinar la sombra dada por el entorno en punto. Éste esta 
formado por una cúpula semitransparente de plástico, de alto poder 
de refl exión, y unos discos que representan la trayectoria solar. Se 
ubica la cúpula sobre un trípode en el punto que queremos estudiar 
y se posiciona debajo de la bóveda traslucida ciertos elementos que 
representan los diagramas polares de la trayectoria solar. El dispositivo 
está dotado de una brújula para un correcto posicionamiento. Una 
vez colocado en el sitio para analizar, el usuario tendrá una visión 
panorámica del entorno como refl ejo en la cúpula, será sufi ciente 
sacar una foto con  cualquier cámara digital de la refl exión.   
Estando privado de electrónica, esta herramienta se podrá usar en 
cualquier lugar y en cualquier condición atmosférica. Los discos de los 
diagramas solares son intercambiables y los proporciona el productor 
al momento de la compra. El Solar Pathfi nder se puede comprar por 
Internet y tiene un precio relativamente bajo, aproximadamente de 
300 $ por el kit. 
Una vez sacada las fotos y pasadas por ordenador, las imágenes serán 
elaboradas por un programa informático, Pathfi nger Assistence Software, 
que gracias a archivos internos permite ofrecer varias posibilidades 
para el cálculo medio ambiental y las instalaciones de energías 
renovables.
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9.2 HORIcatcher [2]

Producido por la industria Suiza Meteotest,  HORIcatcher es un 
instrumento para el estudio de las obstrucciones y los obstáculos a 
la llegada de la radiación solar directa en un punto. Como la Solar 
Pathfi nger, este sistema trabaja por refl exión siendo como el tradicional 
globoscopio, formado por un espejo curvo, que refl eja los elementos 
presentes en la escena alrededor del punto analizado y un especial 
brazo donde está colgada la cámara digital que graba en imagen la 
refl exión del espejo.
Una vez obtenidas las fotos, son elaboradas por un software para PC 
Window, MeteoNorm, que analiza las imágenes obtenidas y permite 
el cálculo de irradiación y soleamiento. La cámara y el espejo están 
posicionados encima de un normal trípode fotográfi co, que permite 
la regulación horizontal gracias a un nivel de burbuja y una brújula.
HORIcatcher, se puede ordenar por Internet y tiene un precio que varia 
entre los 900 y 1000 $.  
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9.3 Panorama Master [3]

Panorama Master, producido por la empresa suiza EnergieBüro,  es un 
especial trípode que nos permite un control de la cámara fotográfi ca 
para fotos panorámicas. Esta herramienta va acompañada de un 
software de análisis de imagen, HorizOn, producido por la misma 
casa, que permite realizar fotos panorámicas en modalidad stitcher, 
juntando una serie de varias fotos, para obtener una de 360º alrededor 
del punto, marcando en la imagen las diferentes trayectorias solares y 
elaborando la cantidad de horizonte libre. Este sistema, a diferencia 
de los que hemos presentado anteriormente, utiliza para el análisis 
proyecciones del entorno y diagramas cilíndricos y no polares1.
Este producto se puede comprar online y tiene un valor, alrededor de 
300 €.

1  Ver capitulo sobre los diferentes tipos de proyecciones.
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9.4 SunEye [4]

Producido por la empresa estadounidense SolmetricTM, SunEye es un 
pequeño instrumento electrónico portátil que permite evaluar el 
potencial de energía solar total dado por la sombra de un determinado 
sitio. Este aparato está presente en el mercado desde el 2006 en dos 
modelos, SunEye 110 y SunEye 210, y es muy usado, sobre todo en los 
Estados  Unidos, por muchos instaladores de paneles solares.
Los dos sistemas están dotados de una pequeña cámara fi sheye que 
permite la visualización del entorno, y gracias a un sistema interno 
admiten procesar las imágenes en el momento. Tiene   navegador 
satelital gracias a un sistema GPS, externo en el caso del modelo 
110 e integrado en modelo 210, y mantiene la perfecta posición en 
cuanto está equipado de una brújula y un nivel de burbuja. Gracias 
a una pequeña pantalla de diferente resolución para los dos modelos, 
permite visualizar de modo muy rápido, los diagramas de trayectoria 
solar y de sombra. Produce una primera estimación de la cantidad 
de radiaciones potenciales en unos meses o en un año y procede a la 
elaboración de unos histogramas. El modelo 210, gracias a un nivel 
de burbuja electrónico, permite calcular los cambios de porcentaje 
de irradiación con el cambio de inclinación. Toda la información es 
almacenada en una pequeña memoria interna y luego pasada a un 
ordenador (compatible con sistemas Windows) por un puerto USB. El 
coste de esta herramienta es relativamente elevado si lo comparamos 
con los sistemas fotográfi co más simples presentados anteriormente, 
y puede variar entre 1.500 $, para el modelo 110, y 2.500$, para el 
modelo 210. Los dos se pueden comprar por Internet pero el SunEye 
210, actualmente, está disponible a la venta únicamente para el 
territorio estadounidense.
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9.5 Solmetric IPV iPhone App [4]

Nos parece interesante presentar por último una aplicación de iPhone, 
adquirido este año por la empresa SolmetricTM. Ésta es una aplicación 
menos precisa que otras que produce la misma casa, pero nos parece 
interesante observar cómo el cálculo solar ha entrado a ser parte de 
nuestra vida cotidiana y cómo un teléfono, por lo sofi sticado que sea, 
nos permite dar un primer análisis de un sitio desde el punto de vista 
solar.  
Solmetric IPV, es una aplicación de iPhone que nos permite una 
evaluación de un lugar y memorizarlo en nuestro teléfono móvil. 
Este permite consultar los datos metereológicos de todo el mundo y 
varias gamas de paneles fotovoltaicos. Utilizando la brújula interna 
del iPhone y el inclinómetro, permite un análisis rápido, dibujando 
el contorno de nuestro horizonte en la pantalla con un cursor a cruz. 
Utilizando una estación meteo basada en el sistema Solmetric IPV 
produce una primera estimación de la energía solar mensual que 
llega en un punto. Permite realizar perfi les de sombra, una previsión 
de la energía que llega, el rendimiento y la producción de un panel 
por cada mes. 
La aplicación se puede bajar de Internet y es muy económica, con un 
gasto de 30 $ se puede tener un instrumento de control en cualquier 
lugar y momento.
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[1]. http://www.solarpathfi nder.com
[2]. http://www.meteotest.com
[3]. http://www.energiebuero.ch
[4]. http://www.solmetrics.com



Conclusiones
 



96

Conclusiones

Cuando comenzamos este trabajo, nuestro principal objetivo era 
desarrollar un método que nos permitiese estudiar la luz directa y 
las sombras en un punto de un espacio arquitectónico, sobre la 
base de la técnica de la Fotografía Hemisférica usada en los estudios de 
ciencia forestal. A medida que fuimos avanzando en el análisis de las 
referencias y estudiando las varias  aplicaciones, nuestros intereses se 
ampliaron hacia nuevos objetivos y temas más complejos. Durante 
la permanencia en Compiègne (Francia) hemos recibido diversos 
estímulos por parte del mundo científi co que se ocupa actualmente del 
análisis medio ambiental en sistemas urbanos, que han infl uenciado 
tanto nuestra curiosidad, siendo capaz de orientar nuestra atención 
desde un simple análisis de la luz directa hacia un más amplio campo 
de estudio de la luz indirecta. 
El interés manifestado por parte de varios profesionales, investigadores 
y fotógrafos, por nuestro análisis ha demostrado la validez del tema. 
Asimismo, la cantidad de publicaciones y material que hemos ido 
encontrando a medida que el argumento se profundizaba, indican  la 
actualidad de su contenido. 

El interés y el desarrollo que en los últimos años se ha mostrado por 
parte del mundo universitario y de la industria por el tema, manifi esta 
un futuro cierto para esta técnica. En efecto, muchas empresas que 
se ocupan de producir herramientas para el control de la luz natural 
para instalaciones de fuentes de energía renovable, están desarrollando 
nuevos dispositivos, cada vez más sofi sticados, que contienen en su 
interior una pequeña cámara digital. En el Workshop que ha tenido 
cita en Compiègne en el mes de Mayo 20101, muchos investigadores 
provenientes de varias partes del mundo, expertos en el análisis de la 
Energía Solar a Escala Urbana, han presentado como importantes 
para sus estudios técnicas fotográfi cas de visión extrema. 

Como resultado de nuestra investigación, hemos conseguido 
desarrollar un método que nos permite analizar con facilidad un 
punto de un espacio construido, sea para el análisis de la luz directa, 
sea para el análisis de la luz indirecta. 
Resulta bastante simple e intuitivo controlar el soleamiento en el 
punto de saque. Para este análisis será sufi ciente tener una fotografía 
fi sheye del cielo, prestando atención en el correcto posicionamiento 
de la cámara, disponer de la adecuada información sobre el tipo de 
objetivo usado y de las máscaras de la trayectoria solar en el sitio por 
su latitud.
El análisis del cielo resulta un poco más laborioso. Programas para la 
evaluación de los píxeles nos ayudan a evidenciar la parte de cielo, y 
contar el porcentaje de éste en relación a la totalidad de la foto para 
obtener factores de vista.

1  SEUS, Solar Energy at Urban Scale, 25 y 26 Mayo 2010
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Desde el principio sabíamos que un análisis del punto hecho con 
fotografías podía dar resultados más reales y precisos de los que se 
pueden obtener con simulaciones del ordenador. En particular, 
estamos muy satisfechos de haber conseguido realizar el análisis 
del factor de vista en el mismo punto en diferentes épocas del año, 
comparando las disímiles condiciones de luz debido a la variación 
de la vegetación. Siendo muy complejo prever el crecimiento de las 
plantas, consideramos que la técnica fotográfi ca es un modo muy 
exacto para determinar la infl uencia de la vegetación, por la luz y 
la sombra, en un espacio arquitectónico. En nuestra opinión, resulta 
importante, con fi nes de investigación científi ca, poder disponer de 
un rico archivo fotográfi co que permita comparar los cambios de 
iluminación en diferentes condiciones de luz. El hecho de ser capaces 
de elaborar los valores de luminancia del cielo y del entorno, nos 
permite controlar con elevada precisión lo que sucede alrededor del 
punto analizado a medida que las condiciones atmosféricas vayan 
mutando. 
Hemos conseguido cuantifi car qué porción de la escena refl eja, 
hacia la cámara, un determinado intervalo de luminancia, pudiendo 
así, estudiar dónde, cuándo y con qué porcentaje los diferentes 
componentes infl uyen en un punto. Esto nos permite considerar los 
elementos construidos, no solo como obstrucción al paso de la luz, si no 
como pantallas refl ectantes, dependiendo del material y de la forma, 
para un mejor aprovechamiento de los rayos electromagnéticos. 
La moderna fotografía digital nos permite, además, registrar un 
elevado número de fotografías para comparaciones y análisis. En 
particular, una monitorización constante y puntual del cielo, puede 
ayudar a comprender los repentinos saltos de niveles de radiación, 
que todavía resultan poco claros a los investigadores, que aparecen en 
las mediciones de la bóveda con piranómetro.
Para nuestro trabajo, hemos elegido realizar un método de análisis 
simple y accesible a cualquier tipo de usuario y por ejemplo, hemos 
utilizado una cámara analógica para los saques de imágenes a ojo de 
pez, de bajo coste y fácil de uso. Este tipo de elección si bien nos ha 
permitido cumplir con nuestro objetivo, ha resultado al mismo tiempo 
una limitación para otros estudios. Disponer de una lente fi sheye para 

nuestra cámara digital hubiese permitido mayor rapidez en nuestro 
análisis. En particular, trabajar con imágenes digitales nos hubiese 
permitido profundizar las posibilidades de la elaboración HDR, que 
en nuestra tesina se presenta con un ejemplo en capítulo 8º.
De todas formas consideramos nuestro trabajo sufi ciente y estamos 
muy satisfechos de los resultados obtenidos. Una parte relevante de 
nuestro tiempo de estudio ha sido necesario dedicarlo a aprender 
nuevos programas informáticos, como ImageJ, PhotospherU, Qtpsfgui, 
WebHDR, SunTools y otros que hemos ya presentado en nuestro 
texto, en cuanto para nosotros eran desconocidos y no tradicionales 
en la formación de un Arquitecto.
Pensamos que técnicas de análisis fotográfi co serán la base en los 
próximos años para estudios medio ambientales y metereológicos. 
Creemos que con los avances de la técnica digital, fotos y videos 
hemisféricos remplazarán los escáneres de cielo para estudios de la 
bóveda celeste, en cuanto son capaces de dar una mayor cantidad de 
información y con una elevada precisión. Opinamos que el análisis 
de imágenes afi ncará, con mayor frecuencia, estudios de modelos 
informáticos para el control de la luz.   

Finalizamos nuestro trabajo contentos de los resultados obtenidos y 
con ganas de seguir profundizando sobre el tema, a fi n de mejorar el 
método de análisis y hacerlo más rápido y preciso, quizás intentando 
desarrollar un software que permita ejecutar toda   la elaboración en 
un único programa.  
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